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CHAPTER 1

Introduction
General Description

Restrictions Editor is a 32-bit, standalone Windows application that gives administrators the ability to create and manage 
detailed restriction files granting or restricting access to resources, assignments and features of AZedit through the use of a 
graphical interface to the restriction file. These files can be loaded into AZedit for a more developed and detailed 
Authentication1 application.

A user interface is used to view the restrictions text file and allows you to view and modify the restrictions set for each AZedit 
user you create. The Restrictions Editor groups related sets of resources and features together on easily navigable screens so 
you can conveniently examine and change the restriction sets in context. Restrictions are implemented by having separate 
restriction files for individual intercoms (each of which could contain separate sets of user restrictions). 

NOTE: AZedit includes support for user restrictions by reading a text file and parsing out the set of resources and 
features available to each user. The text file is plain ASCII text and can be viewed with a text editor. For security 
purposes, the text file includes a CRC (Cyclic Redundancy Checksum) tag at the end of the file so that it may not 
be manually edited without corrupting the CRC file, thus corrupting the restriction file.

With the introduction of Authentication in AZedit V3.0.1 and higher, it is necessary to enforce that restriction files have the 
same name as the intercom they are used in. Because Restrictions Editor was made as a centralized application to create 
restrictions for multiple intercoms, it did not makes sense to have a file named Default.res. This does not lend itself easily to a 
multiple intercom environment.

When using Restrictions Editor in concert with AZedit, you must manually add users to the Authentication table and they must 
exactly match to the users created in Restrictions Editor. (case-sensitive)

1. Authentication is the process of determining whether someone is, in fact, who he or she declares to be. In private and public computer 
networks (including the Internet), and similarly AZedit, authentication is commonly done through the use of user profiles and passwords. 
Intercoms supporting authentication may require a username and password for each AZedit session.
3



System Requirements
System Requirements
Before you install RTS Restrictions Editor be sure you have the following installed on the PC:

• Windows 2000/XP/Vista/72

• RTS AZedit Configuration Software must be running on the PC. Restrictions Editor requires a copy of 
Azedit.exe be available in order to determine the AZedit menu structure for creating restrictions.

Restrictions Editor Hierarchy
In Restrictions Editor there are three (3) ways a user’s restriction set can be determined:

• By Studio
• By Class
• By User

A change made to a user stays with the user and does not affect the Class restrictions. However, a change made to the Class 
restrictions affects all the users in the Class. And, changes made to the Studio restrictions affects all the classes in the studio 
and subsequently all the users in the class.

Studios
A Studio allows you to group different resources together according to specific needs. For instance, you might have a large 
intercom which serves several studios in your plant. Each studio uses a number of keypanel ports, IFBs, party lines, etc. 
Restrictions Editor lets you create and name these studios, and assign groups of resources to each studio.

Studios allow you to group users together based on the resources they use.

2. Restrictions Editor may also be run under Windows NT/95/98/ME with Internet Explorer 6.0 or later; however, the application has not 
been tested in this configuration.

FIGURE 29. Restrictions Editor Hierarchy
4



Restrictions Editor Hierarchy
Classes
A Class is a group that holds similar restriction sets, where users can be assigned. You can create any number of classes and 
then create a set of restrictions for each class. This promotes an efficient and effective method of maintaining the security of 
the intercom system. 

When classes are used to setup restriction files, changes made to a class’s restriction set affects every member of the class. For 
example, you could have 25 users assigned to the IFB class, make a change to that class’s restrictions set, therefore affecting 
25 user restriction sets.

Classes allow you to quickly assign individual users with the same restriction sets to a class, making restriction set 
maintenance efficient and easy.

Users
Users are individuals who use AZedit, from administrators to keypanel operators. Individual users are assigned a set of 
restrictions. These restrictions limit what the user can and cannot access or perform within AZedit.
5



Restrictions Editor Hierarchy
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CHAPTER 2

Installation and Configuration
Application Installation
A default directory is created when Restrictions Editor is installed. It is located at C:\TELEX\RESEDIT\Vxxx.

NOTE: Verify you have all the “System Requirements” on page 4 to run the application.

To install Restrictions Editor, do the following:

1. Insert the Restrictions Editor CD into the computer.
The Restrictions Editor window appears.

2. Click Setup.exe.
The Restrictions Editor installation wizard begins.

3. Follow the on screen instructions, taking the defaults.
Restrictions Editor is installed on the computer.

NOTE: A shortcut to Restrictions Editor is created on the Start menu (Start|Programs|ResEdit).
7



Starting Restrictions Editor for the First Time
Starting Restrictions Editor for the First Time
To start Restrictions Editor for the first time, do the following:

1. From the Start menu, select Programs|ResEdit.
The Restrictions Editor window appears.

2. Click OK.
The Preferences window appears.

IMPORTANT: ResEdit stores the restrictions in C:\Telex\ResEdit\RES. Verify AZedit is pointed at this directory using 
Options | Preferences | Authentication. For more information, see “Configure Restrictions Editor in 
AZedit” on page 59.

There are two (2) settings in AZedit: 
Restrictions Files, pointed to C:\Telex\ResEdit\RES, and Restriction Cache Files, pointed to 
C:\Telex\AZedit\RES.

The reason for the two (2) directories is the first may be a network drive. When AZedit starts up, it 
looks at the first directory for the restriction file and if it finds it, it copies it to its local Cache directory. 
That way if the network is unavailable, AZedit can always fall back to the locally cached copy.

Note, these two directory settings are per user per intercom in AZedit. When you change a user or 
intercom, you must make sure these settings are correct for current user/intercom.
8



Starting Restrictions Editor for the First Time
3. Make any modifications to the preferences as needed.
4. Click OK.

The Select Intercom window appears.

5. Select the Intercom you want to connect to.
6. Click OK.

The Refreshing Alphas screen appears and Restrictions Editor is started.
7. Using the following chapters, configure Restrictions Editor as needed.
9



Application Reference View
Application Reference View

Context Navigation Tree
The Context Navigation Tree, shown in Figure 30, located in the upper-left window pane, is used to move throughout the 
intercom system with the click of a mouse. 

The root node of the navigation tree contains the Intercom item. This item allows you to view intercom configurations and 
capabilities and resources.

There are three (3) subnodes beneath Intercom: 

Studios - a set of resources that can be included or excluded in the restriction set of a Class or User.

Classes - a set of restrictions that a user can inherit as a base restriction set.

Users - a set of restrictions specifically designed for an individual.

Selecting any of these nodes allows you to Add, Delete, Rename and assign restrictions to various assignments, resources, and 
features.

FIGURE 30. Application Reference View
10



Application Reference View
Resource Navigation Bar
The Resource Navigation Bar, shown in Figure 30, is used to jump to different resources associated with a studio, class, or 
user. The configuration button allows you to add, rename, or delete studios, classes, or users. Each resource, with the exception 
of configuration, contains individual resources you can include in a restriction set. Special, AZedit and Menus, at the bottom of 
the navigation bar are global features that can be included in a restriction set.

The available resources are:

IMPORTANT: By default, all resources in Restrictions Editor are set to Deny.

Data View
The Data View, shown in Figure 31, displays a list of the related features and resources and indicates whether or not the 
feature or resource is accessible in the current context by showing a checkmark (Allow) or an X (Deny) in the left column. 

Configuration - Used to create specific studios, 
classes, or users. For more information, see 

Keypanels

Party Lines

IFBs

IFB Special Lists

Special Lists

GPI Outputs

ISOs

GPI Inputs

Assignment Groups

Auto Dials

UPL Resources

UPL Statements

Dim Tables

LCP-102s

PAP-32s

I/O Cards

Special

AZedit

Menus

FIGURE 31. Data View 
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Application Reference View
Resource/Feature Group Tabs

The Resource/Feature Group tabs, shown in Figure 32, located at the bottom of the Data View pane, represent a related set 
of resources or features associated with the item selected in the Resource Navigation Bar.

There are five (5) pages available to display resources or features. 

NOTE: Not every item in the Resource Navigation Bar has all five (5) pages.

Available options are:

Resource Page - Every resource has this page, except Special, AZedit and Menu.

Assignment Page

Feature Page

Alpha Page

Scroll Enable Page

FIGURE 32. Resource/Features Group Tabs
12



Application Reference View
Status Bar
The Status Bar, shown in Figure 33, relays two (2) pieces of information—how to access the help file and if the current 
restriction file is read only. If the restriction file is read-only, no modifications can be made to the file.

Context Bar
The Context bar, shown in Figure 34, is used to display a visual navigational string relationship to the restrictions you see. It 
also contains the previous and next buttons that allow you to move through all of the context views in a ordered and 
chronological fashion.

FIGURE 33. Status Bar

FIGURE 34. Context Bar
13



Application Reference View
Toolbar
The Toolbar, shown in Figure 35, is used to change intercoms, refresh alphas, save restriction files, and to access help, release 
notes, and application information.

The toolbar consists of seven (7) icons. 

Menu Bar
The Menu Bar, shown in Figure 35, is used to access every window the toolbar can access as well as exporting restriction 
files, modifying preferences, and creating shortcuts on your desktop.

FIGURE 35. Menu and Tool Bars

TABLE 1. Toolbar Icon Description Table

Icon Description

Change Intercom

Refresh Alphas

Save Restrictions

Help

What’s This

What’s New

About Restrictions Editor
14



CHAPTER 3

Studios
Studio Configuration Window
The Studio Configuration Window, shown in Figure 36, is used to Add, Delete and Rename studios. For more information 
on studios, see “Studios” on page 4.

Studios Column
The Studios column displays a list of created studios.

Add Button
The Add button opens the Add New Studio window. From this window, you can create a new studio. For more information, 
see “Add New Studio Window” on page 16.

FIGURE 36. Studio Configuration Window
15



Add New Studio Window
Delete Button
The Delete button is used to remove a studio from the list. When the Delete button is clicked, a popup message appears 
confirming the deletion. 

Rename Button
The Rename button opens the Rename window. From this window, you can rename the selected studio. For more information, 
see “Rename Window” on page 17.

Add New Studio Window
The Add New Studio window, shown in Figure 37, is used to create a new studio.

Enter The New Studio Name: Field
The Enter the new studio name field is used to create a studio. 

This field can contain up to 24 characters.

OK Button
The OK button is used to accept the new studio name. Once OK is clicked, the studio name appears in the Content Navigation 
Tree under Studio.

Cancel Button
The Cancel button is used to close the Add New Studio window without creating a new studio.

FIGURE 37. Add New Studio Window
16



Rename Window
Rename Window
The Rename window, shown in Figure 38, is used rename a studio.

Enter New Name: Field
The Enter new name field is used to assign a new name to the studio. 

This field can contain up to 24 characters.

OK Button
The OK button is used to accept the new name. Once OK is clicked, the new name appears in the Content Navigation Tree 
under Studio.

Cancel Button
The Cancel button is used to close the Rename window without making any modifications.

FIGURE 38. Rename Window
17



Studio:Resources Page
Studio:Resources Page
The Studio Resources page, shown in Figure 39, displays the resources you can include in your studio. Resource restrictions 
determine if a resource can be edited. If you are restricted from a resource, then you cannot change any of its features 
including alphas and scroll enables in AZedit. 

Included? Check Box
The Included? check box is used to select a resource to assign to a specific studio the resource is included in.

# Column
The # column displays the resource number.

Alpha Column
The Alpha column displays the alpha name assigned to the resource.

Description Column
The Description column displays the description of the resource.

FIGURE 39. Studio Resources Page
18



Studio:Assignments Page
Studio:Assignments Page
The Studio Assignments page, shown in Figure 40, is used to select assignments you are allowing members of the studio to 
modify the restrictions for. 

The only resources that have assignment pages in a studio are, Keypanels, Party Lines, IFBs, IFB Special Lists, Special Lists, 
GPI Outputs, ISOs, and UPL Resources. 

Included Check Box
The Included check box is used to select assignments to include in a particular studio.

# Column
The # column displays the number assigned to the assignments.

Alpha Column
The Alpha column displays the alpha name assigned to the assignment.

Description Column
The Description column displays the description of the assignment.

FIGURE 40. Studio Assignments Page
19



Studio:Assignments Page
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CHAPTER 4

Classes and Users
IMPORTANT: By default, all resources in Restrictions Editor are set to Deny.

Class Configuration Window
The Class Configuration window, shown in Figure 41, is used to create and maintain classes in Restrictions Editor. From this 
window, you create, define, and maintain classes. For more information on classes, see “Classes” on page 5. 

FIGURE 41. Class Configuration Window
21



Add New Class Window
Classes Column
The Classes column displays a selectable list of user-defined classes in the Restriction file.

Add Button
The Add button is used to open the Add a New Class window. For more information, see “Add New Class Window” on 
page 22.

Delete Button
The Delete button is used to remove classes from the Restriction File. 

Rename Button
The Rename button is used to open the Rename window. For more information, see “Rename Window” on page 17.

Add New Class Window
The Add New Class window, shown in Figure 42, is used to create new classes in Restrictions Editor. By default, class 
permission sets are all configured to deny. From this window, you can choose the type of permission set you want your class to 
inherit: default permissions, from an existing class or from an existing user.

With default permission Radio Button
The With Default Permission radio button is used to assign default permissions to the new class.

With initial permissions copied from Class Radio Button
The With initial permissions copied from Class radio button is used to assign initial permissions copied from an existing 
class. You select the class from the Class drop down menu.

Class Drop Down Menu
The Class drop down menu is used to select the class you want to copy permissions from for the new class. Available 
selections are user-defined.

FIGURE 42. Add New Class Window
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Add New Class Window
With initial permissions copied from User Radio Button
The With initial permissions copied from User radio button is used to assign initial permissions copied from an existing 
user. Select the user from the User drop down menu.

User Drop Down Menu
The User drop down menu is used to select the user you want to copy permissions from for the new class. Available selections 
are user-defined.

Enter the new Class name: Field
The Enter the new Class name: field is used to name the new class.

This field can contain up to 24 characters.

OK Button
The OK button is used to accept the new class and close the Add New Class window.

Cancel Button
The Cancel button is used to close the Add New Class window without creating a new class.
23



Individual Class Configuration Window
Individual Class Configuration Window
The Individual Class Configuration window, shown in Figure 43, is used to further specialize class permissions by including 
or excluding specific resources associated with existing studios, and ranking studios to include or exclude certain resources. 
Also from this window, entire permission sets can be configured by using the Allow All, Deny All, or Inherit All buttons.

NAVIGATION: Select a Class from the Class branch of the Context Navigation Tree.

Left Studio Column
The Left Studio column displays a list of existing studios you can select to include in an individual class permissions file.

Include Button
The Include button is used to add studios to be included in a permission set for a class. Include means this class or user has 
access to all the resources defined in the selected studio. Included studio are shown with a green plus in the right column 
(see Figure 44).

Exclude Button
The Exclude button is used to move a selected studio from the left column to the right column. Exclude means this class or 
user does not have access to the resources in the selected studio. Excluded studios are shown with a red dash in the right 
column (see Figure 44).

FIGURE 43. Individual Class Configuration Window
24



Individual Class Configuration Window
Remove Button
The Remove button is used to move a studio from the right column to the left column. By removing a studio from the right 
column means the class or user no longer can access the selected studio.

Move Up Button
The Move Up button is used to move a studio in the right column up in position in the list. This button is used when the class 
or user is included in one (1) studio but excluded from another, and both studios share resources for Port 10. You can rank the 
studios where the higher ranked studio allows or restricts permission for the resource. 

EXAMPLE: User 1 has Studio A included in their permission set and has Studio B excluded from their 
permission set. Studio A and Studio B share a common resource–Port 10. If studio B is listed above 
studio A in the right column list, then Port 10 is restricted from User 1; however, if studio A is listed 
above studio B in the right column list, then port 10 is accessible to User 1.

Move Down Button
The Move Down button is used to move a studio in the right column down in position in the list. This button is used when the 
class or user is included in one (1) studio but excluded from another, and both studios share resources for Port 10. You can rank 
the studios where the higher ranked studio allows or restricts permission for the resource. 

EXAMPLE: User 1 has Studio A included in their permission set and has Studio B excluded from their 
permission set. Studio A and Studio B share a common resource–Port 10. If studio B is listed above 
studio A in the right column list, then Port 10 is restricted from User 1; however, if studio A is listed 
above studio B in the right column list, then port 10 is accessible to User 1.
25



Individual Class Configuration Window
+/- Column
The +/- column displays if a studio is included or excluded from a class or user. A green plus sign denotes inclusion; a red 
minus sign denotes exclusion. See Figure 44.

Studio Column
The Studio column displays the studios you select to be included in the class or user permission set.

Allow All Button
The Allow All button is used to set every resource in the restriction file to allow access (green check mark).

Deny All Button
The Deny All button is use to set every resource in the restriction file to deny access (red x). 

IMPORTANT: By default, all resources in Restrictions Editor are set to Deny.

Inherit All Button
The Inherit All button is used to remove any (allow or deny) overrides that have been made to the class or user, without 
removing access to studios and their resources, if applicable.

FIGURE 44. Include and Exclude
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User Configuration Window
User Configuration Window
The User Configuration window, shown in Figure 45, is used to create and maintain users in Restrictions Editor. From this 
window, you create, define, and maintain users. For more information, see “Users” on page 5.

Users Column
The Users column displays a selectable list of existing users in the Restriction file.

Add Button
The Add button is used to open the Add a New User window. For more information, see “Add New User Window” on 
page 28.

Delete Button
The Delete button is used to remove users from the Restriction file. 

Rename Button
The Rename button is used to open the Rename window. For more information, see “Rename Window” on page 17.

FIGURE 45. User Configuration Window
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Add New User Window
Add New User Window
The Add New Class window, shown in Figure 46, is used to create new users in Restrictions Editor. By default, user 
permission sets are all set to deny. From this window, you can choose the type of permission set you want the user to inherit; 
default permissions, from an existing class, or from an existing user.

IMPORTANT: Integrating Restrictions Editor to an existing AZedit program that currently has established users in the 
system (via Authentication), to avoid confusion, be sure the user name record in both applications 
match exactly to avoid duplicate records. User names are case sensitive. AZedit accesses the list of 
users for an intercom from the registry. However, when AZedit detects a restriction file, it reads the 
restrictions file user name table first. 

With Default Permission Radio Button
The With Default Permission radio button is used to assign default permissions to the new user. By default, all resources are 
denied.

With initial permission copied from Class Radio Button
The With initial permission copied from Class radio button is used to assign initial permissions copied from an existing 
class. You select the class from the Class drop down menu.

Class Drop Down Menu
The Class drop down menu is used to select the class you want to copy permissions from for the new class. Selections are 
user-defined.

With initial permission copied from User Radio Button
The With initial permission copied from User radio button is used to assign initial permissions copied from an existing user. 
You select the user from the User drop down menu.

User Drop Down Menu
The User drop down menu is used to select the user you want to copy permissions from for the new user. Selections are 
user-defined.

FIGURE 46. Add New User Window
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Individual User Configuration Window
Enter the new User name: Field
The Enter the new user name: field is used to name the new user.

This field can contain up to 24 characters.

OK Button
The OK button is used to accept the new user and close the Add New User window.

Cancel Button
The Cancel button is used to close the Add New User window without creating a new user.

Individual User Configuration Window
The Individual User Configuration window, shown in Figure 47, is used to further specialize user permissions by including 
or excluding specific resources associated with existing studios, and ranking studios to include or exclude certain resources. 
Also from this window, entire permission sets can be configured by using the Allow All, Deny All, or the Inherit All buttons.

Studio Column
The Studio column displays a list of existing studios you can select to include in an individual class permissions file.

FIGURE 47. Individual User Configuration Window
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Individual User Configuration Window
Include Button
The Include button is used to add studios to be included in a permission set for a class. Studios are classifications of resources 
and assignments available to all classes and users; these studios are included in their permission sets. Included studios are 
shown with a green plus sign in the right column (see Figure 44).

Exclude Button
The Exclude button is used to move a selected studio from the left column to the right column. Exclude means this class or 
user does not have access to the resources in the selected studio. Excluded studios are shown with a red dash in the right 
column (see Figure 44).

Remove Button
The Remove button is used to move a studio from the right column to the left column. By removing a studio from the right 
column means the class or user no longer references the selected studio.

Move Up Button
The Move Up button is used to move a studio in the right column up in position in the list. This button is used when the class 
or user is included in one (1) studio but excluded from another, and both studios share resources for Port 10. You can rank the 
studios where the higher ranked studio allows or restricts permission for the resource. 

EXAMPLE: User 1 has Studio A included in their permission set and has Studio B excluded from their 
permission set. Studio A and Studio B share a common resource–Port 10. If studio B is listed above 
studio A in the right column list, then Port 10 is restricted from User 1; however, if studio A is 
listed above studio B in the right column list, then port 10 is accessible to User 1.

Move Down Button
The Move Down button is used to move a studio in the right column down in position in the list. This button is used when the 
class or user is included in one (1) studio but excluded from another, and both studios share resources for Port 10. You can 
rank the studios where the higher ranked studio allows or restricts permission for the resource. 

EXAMPLE: User 1 has Studio A included in their permission set and has Studio B excluded from their 
permission set. Studio A and Studio B share a common resource–Port 10. If studio B is listed above 
studio A in the right column list, then Port 10 is restricted from User 1; however, if studio A is 
listed above studio B in the right column list, then port 10 is accessible to User 1.

+/- Column
The +/- column displays if a studio is included or excluded from a class or user. A green plus sign denotes inclusion; a red 
minus sign denotes exclusion. See Figure 48.
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Individual User Configuration Window
Studio Column
The Studio column displays the studios you select to be included in the class or user permission set.

Allow All Button
The Allow All button is used to set every resource in the permissions set of a class or user to allow access (green check mark).

Deny All Button
The Deny All button is used to set every resource in the permissions set of a class or user to deny access (red x). 

IMPORTANT: By default, all resources in Restrictions Editor are set to Deny.

Inherit All Button
The Inherit All button is used to remove any (allow or deny) overrides permissions that have been made to the class or user, 
without removing access to studios and their resources, if applicable. 

FIGURE 48. Include and Exclude
31



Resources Page
Resources Page

NOTE: Because Classes and Users share the same resources, they are discussed together in this section.

The Resources page, shown in Figure 49, displays a list of resources available to classes and users. From this page, you can 
select the resources a class or user is allowed access to or is denied access from.

The following resources have an assignments page: Keypanels, Party Lines, IFBs, IFB Special Lists, Special Lists, GPI 
Outputs, ISOs,GPI Inputs, Assignment Groups, Auto Dials, UPL Resources, UPL Statements, Dim Tables, LCP-102s, 
PAP-32s, ARP-32s, and I/O Cards.

FIGURE 49. Class and User Resources Window
32



Resources Page
Access Column
The Access column displays whether to the resource is allowed or denied to the user.

# Column
The # column displays the port number of the resource.

Alpha Column
The Alpha column displays the alpha name of the resource. The alpha can be changed in AZedit on the appropriate Alphas 
page. 

For more information, see the AZedit User Manual located at http://www.rtsintercoms.com/binary/AZ-
Edit%20User%20Manual.pdf. 

Description Column
The Description column displays a description of the resource, if available. 

Allow Column
The Allow column is used to grant access to the resource for modifications.

Deny Column
The Deny column is used to restrict access to the resource for modifications.

Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.

By default, the initial permissions set is set to Deny.
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Assignments Page
Assignments Page

NOTE: Because Classes and Users share the same assignments, they are discussed together in this section.

The Assignments page, shown in Figure 50, displays a list of assignments available to classes and users. From this page, you 
can select the assignments a class or user is allowed access to or is denied access from.

The following resources have an assignments page: Keypanels, Party Lines, IFBs, IFB Special Lists, Special Lists, GPI 
Outputs, ISOs, and UPL Resources.

Access Column
The Access column displays whether to the resource is allowed or denied to the user.

FIGURE 50. Class and User Assignments Window
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Assignments Page
# Column
The # column displays the port number of the resource.

Alpha Column
The Alpha column displays the alpha name of the resource. The alpha can be changed in AZedit on the appropriate Alphas 
page. 

For more information, see the AZedit User Manual located at http://www.rtsintercoms.com/binary/AZ-
Edit%20User%20Manual.pdf. 

Description Column
The Description column displays a description of the resource, if available. 

Allow Column
The Allow column is used to grant the user access to modify resources.

Deny Column
The Deny column is used to restrict access to the resource for modifications.

Inherit Column
The Inherited column displays the initial permission state of the resource, assignment or feature. If the user or class inherited 
permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.
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Features Page
Features Page

NOTE: Because Classes and Users share the same features, they are discussed together in this section.

The Features page, shown in Figure 51, displays a list of features associated with a resource from the Resource Navigation 
Bar. Each resource has a different list of features. For detailed information, see Table 2 on page 38.

The following resources have a Features page: Keypanels, Party Lines, IFBs, IFB Special Lists, Special Lists, GPI Outputs, 
GPI Inputs, Assignment Groups, Auto Dials, UPL Resources, UPL Statements, Dim Tables, LCP-102s, 
PAP-32s, ARP-32s, and I/O Cards

Access Column
The Access column displays whether access to the resource is allowed or denied to the user.

FIGURE 51. Class and User Features Window
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Features Page
Feature Column
The Feature column displays the name of the feature.

Allow Column
The Allow column is used to grant access to the assignment for modifications.

Deny Column
The Deny column is used to restrict access to the assignment for modifications.

Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and display in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.
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Features Page
TABLE 2. Resources and Features Description

Resource Feature Description
Keypanels

Latch Disables Allow or Deny the ability to latch disable a keypanel key.
Key Restrictions Allow or Deny the ability to restrict a keypanel key.
Talk Assignments Allow or Deny the ability to assign talk assignments in 

AZedit.
Listen Assignments Allow or Deny the ability to assign listen assignments in 

AZedit.
Key Labels Allow or Deny the ability to assign key labels to keypanel 

port.
Key States Allow or Deny the ability to modify keypanel states.
Keypanel Type Allow or Deny the ability to change a keypanel type.
Default View Allow or Deny the ability to change the default view in 

AZedit.
Setup Page Map Allow or Deny the ability to modify the setup page mappings.
Setup Restrict Allow or Deny the ability to restrict setup changes.
IFB Priority Allow or Deny the ability to modify the IFB Priority levels.
Trunk Priority Allow or Deny the ability to modify the Trunk Priority levels.
Trunk IFB Priority Allow or Deny the ability to modify the IFB Trunk Priority 

levels.
IFB Listen Destination Allow or Deny the ability to change the IFB Listen 

Destination.
PGM Listen Destination Allow or Deny the ability to change the PGM Listen 

Destination.
Poll Delay Allow or Deny the ability to modify the panel poll delay field.
Tone Enable Allow or Deny the ability to start Tone Enable.
Keypanel Privacy Allow or Deny the ability to enable keypanel privacy.
TIF Dial Out Restriction Allow or Deny the ability to enable TIF dial out restrictions.
Port Is TIF Allow or Deny the ability to assign Port Is TIF on a port.
Do Not Interrupt Allow or Deny the ability to enable the Do Not Interrupt 

feature.
Vox Settings Allow or Deny the ability to configure Vox settings.
Port is Active Device Flag Allow or Deny the ability to set the port is active device flag.
Keypanel Screen Saver Allow or Deny the ability to create or modify a keypanel 

screen saver.
Keypanel Menu Passwords Allow or Deny the ability to create or modify a keypanel menu 

password.
Force and Inhibit Crosspoints Allow or Deny the ability to force and inhibit crosspoints.
Crosspoint Gains Allow or Deny the ability to modify crosspoint gain levels.
Party Line Gains Allow or Deny the ability to modify party line gain levels.
Analog Gains Allow or Deny the ability to modify analog gain levels.
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Features Page
Party Line
Local Tally Allow or Deny the ability to set a local tally on a port.
Trunk Tally Allow or Deny the ability to set a trunk tally on a port.
Membership Allow or Deny the ability to become a member of a party line.

IFB
Input Port Allow or Deny the ability to create or modify the input port.
Output Port Allow or Deny the ability to create or modify the output port.
Dim Amount Allow or Deny the ability to create or modify the dim amount.
Listen Source Allow or Deny the ability to create or modify the listen source.

IFB Special 
List Membership Allow or Deny the ability to become a member of an IFB 

special list.
Special List

Relays Allow or Deny the ability to create or modify relays.
Membership Allow or Deny the ability to become a member of a special 

list.
GPI Output

Input Port Allow or Deny the ability to create or modify the GPI Output 
input port.

Output Port Allow or Deny the ability to create or modify the GPI Output 
output port.

ISO
ISO Self Flag Allow or Deny the ability to isolate the current port.
Output Port Allow or Deny the ability to create or modify the ISO output 

port.
GPI Input

Definition Allow or Deny the ability to create or modify the GPI input 
definition.

Assignment 
Group Membership Allow or Deny the ability to become a member of an 

Assignment Group.
Membership Only Flag Allow or Deny the ability to make assignment group members 

scroll enabled.
Auto Dials

Phone Number Allow or Deny the ability to create or modify phone numbers 
in Auto Dial windows.

UPL 
Resource Input Port Allow or Deny the ability to create or modify the input port for 

a UPL resource.
Output Port Allow or Deny the ability to create or modify the output port 

for a UPL resource.
Reciprocal Flag Allow or Deny the ability to set the reciprocal flag for a UPL 

resource.

TABLE 2. Resources and Features Description

Resource Feature Description
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Features Page
UPL 
Statement Definition Allow or Deny the ability to create or modify the definition for 

a UPL Statement.
Dim Table

Gain Allow or Deny the ability to create or modify the gain level for 
the Dim table.

Membership Allow or Deny the ability to be a member of a Dim table.
LCP-102

PAP Mode Assignments Allow or Deny the ability to create or modify PAP mode 
assignments.

PAP Mode Enable Allow or Deny the ability to enable PAP mode.
PAP Mode Setup Page Allow or Deny the ability to modify the PAP mode setup 

pages.
CDP Mode Assignments Allow or Deny the ability to create or modify CDP mode 

assignments.
CDP Mode Enable Allow or Deny the ability to enable CDP mode.
CDP Mode Setup Page Allow or Deny the ability to modify the CDP mode setup 

pages.
Analog Gain Mode Assignments Allow or Deny the ability to create or modify analog gain 

mode assignments.
Analog Gain Mode Enable Allow or Deny the ability to enable analog gain mode.
Analog Gain Mode Setup Page Allow or Deny the ability to modify the analog gain mode 

mode setup pages.
ARP-32

Assignments Allow or Deny the ability to create or modify ARP-32 
assignments.

Key Restrictions Allow or Deny the ability to create or modify key restrictions 
for the ARP32.

Setup Restrictions Allow or Deny the ability to create or modify setup restrictions 
for the ARP-32.

Setup Page Map Allow or Deny the ability to change the setup page.

TABLE 2. Resources and Features Description

Resource Feature Description
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Features Page
I/O Card
Reference Clock Allow or Deny the ability to change the reference clock. 

MADI Configuration Only.
Sample Rate Allow or Deny the ability to change the sample rate. MADI 

Configuration Only.
Link Mode Allow or Deny the ability to change the link mode. MADI 

Configuration Only.
Pass-Through Baud Rate Allow or Deny the ability to change the pass-through baud 

rate. MADI Configuration Only.
Number of Channels Allow or Deny the ability to change the number of channels. 

MADI Configuration Only.
Channel Mappings Allow or Deny the ability to change the channel mappings. 

MADI Configuration Only.
Channel Mute Allow or Deny the ability to change the channel mute setting. 

MADI Configuration Only.

TABLE 2. Resources and Features Description

Resource Feature Description
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Alphas Page
Alphas Page

NOTE: Because Classes and Users share the same alphas, they are discussed together in this section.

The Alphas page, shown in Figure 52, displays a list of alpha page features available for classes or users to modify. From this 
page, you can select the features a class or user is allowed or denied access from.

The following resources have an Alphas page: Keypanels, Party Lines, IFBs, IFB Special Lists, Special Lists, GPI Outputs, 
ISOs, GPI Inputs, Assignment Groups, Auto Dials, UPL Resources, Dim Tables, PAP-32s and I/O Cards.

Access Column
The Access column displays whether access to the resource is allowed or denied to the user.

FIGURE 52. Class and User Alphas Window
42



Alphas Page
Feature Column
The Feature column displays the name of the feature.

Allow Column Check Box
The Allow column is used to grant access to the assignment for modifications.

Deny Column Check Box
The Deny column is used to restrict access to the assignment for modifications.

Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature. 
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Scroll Enables Page
Scroll Enables Page

NOTE: Because Classes and Users share the same scroll enables, they are discussed together in this section.

The Scroll Enables page, shown in Figure 53, displays a list of scroll enable features available for classes or users to modify. 
From this page, you can select the features a class or user is allowed or denied access from.

The following resources have an Alphas page: Keypanels, Party Lines, IFBs, IFB Special Lists, Special Lists, ISOs, GPI 
Inputs, Assignment Groups, Auto Dials, UPL Resources

FIGURE 53. Class and User Scroll Enables Window
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Scroll Enables Page
Access Column
The Access column displays whether to the resource is allowed or denied to the user.

Feature Column
The Feature column displays the name of the feature.

Allow Column Check Box
The Allow column is used to grant access to the assignment for modifications.

Deny Column Check Box
The Deny column is used to restrict access to the assignment for modifications.

Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.
45



Special Assignments Window
Special Assignments Window
The Special Assignments window, shown in Figure 54, displays a list of features associated with the AZedit special functions 
(see Table 3 on page 47). Special functions are special key assignments that further aid keypanel users. From this page, you 
can select the features a class or user is allowed or denied to access...

Special functions for talk keys

All-Call (AC) 
DIM 

Special functions for listen keys

Auto-Follow (AF) 
Auto-Listen (AL) 
Auto-Mute (AM) 
Auto-Reciprocal (AR) 
Auto-Table (AT) 

FIGURE 54. Special Assignments Window
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Special Assignments Window
Access Column
The Access column displays whether to the resource is allowed or denied to the user.

Feature Column
The Feature column displays the name of the feature.

Allow Column Check Box
The Allow column is used to grant access to the assignment for modifications.

Deny Column Check Box
The Deny column is used to restrict access to the assignment for modifications.

Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.

TABLE 3. Special Features List

Feature Description
Null Assignments (----) Allow or Deny the ability to modify null assignments.
Auto-Follow Assignments (AF) Allow or Deny the ability to modify auto-follow assignments.
Auto-Table Assignments (AT) Allow or Deny the ability to modify auto-table assignments.
Auto-Listen Assignments (AL) Allow or Deny the ability to modify auto-listen assignments.
Auto-Reciprocal Assignments (AR) Allow or Deny the ability to modify auto-reciprocal assignments.
Auto-Mute Assignments (AM) Allow or Deny the ability to modify auto-mute assignments.
All Call Assignments (AC) Allow or Deny the ability to modify all call assignments.
Dim Table Assignments (DIM) Allow or Deny the ability to modify dim table assignments.
Remote (trunked) Assignments Allow or Deny the ability to modify remote (trunked) assignments.
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AZedit Features Window
AZedit Features Window
The AZedit Features window, shown in Figure 55, displays a list of features available in AZedit (see Table 4 on page 49).

Access Column
The Access column displays whether to the feature is allowed or denied to the user.

Feature Column
The Feature column displays the name of the feature.

Allow Column Check Box
The Allow column is used to grant access to the feature for modifications.

FIGURE 55. AZedit Features Window
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AZedit Features Window
Deny Column Check Box
The Deny column is used to restrict access to the feature for modifications.

Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.

TABLE 4. AZedit Features

Feature Description
Change Setup Preferences Allow or Deny the ability to change Setup Preferences in AZedit.
Change Alpha Preferences Allow or Deny the ability to change Alpha Preferences in AZedit.
Change Logging Preferences Allow or Deny the ability to change Logging Preferences in AZedit.
Change General Preferences Allow or Deny the ability to change Setup Preferences in AZedit.
Change Advanced Preferences Allow or Deny the ability to change Advanced Preferences in AZedit.
Change Authentication Preferences Allow or Deny the ability to change Authentication Preferences in AZedit.
Change Maintenance Preferences Allow or Deny the ability to change Maintenance Preferences in AZedit.
Download Firmware Allow or Deny the ability to download firmware.
Download Keypanel Fonts Allow or Deny the ability to download keypanel fonts.
Perform First Birthday Allow or Deny the ability to perform a first birthday.
Re-Configure Intercom Allow or Deny the ability to reconfigure the intercom.
Change Communications Parameters Allow or Deny the ability to change the communication parameters for the 

matrix.
View Communications Statistics Allow or Deny the ability to view the communications statistic.
View Device Memory Allow or Deny the ability to view device memory.
Change Logging State Allow or Deny the ability to change the logging state.
Clear Message Counters Allow or Deny the ability to clear the message counters.
Clear “Bad Cut” Status Allow or Deny the ability to clear the “bad cut” status.
Clear Key Closures for Disconnected 
Keypanels

Allow or Deny the ability to clear key closures for disconnected panels.

Remove Trunk Port Allow or Deny the ability to remove trunk ports.
Clear Trunk Assigns Allow or Deny the ability to clear trunk assignments.
Context Sensitive Help Allow or Deny the ability to use the context sensitive help.
View RVON Configuration Allow or Deny the ability to view the Rvon Configuration window.
Edit RVON Configuration Allow or Deny the ability to edit the Rvon Configuration window.
View Debug Terminal Allow or Deny the ability to view the debug terminal.
Customize Toolbars Allow or Deny the ability to customize toolbars.
Search & Replace Allow or Deny the ability to perform a search and replace.
Edit GPIO Configuration Allow or Deny the ability to edit the GPIO Configuration window.
Hide Alarms Allow or Deny the ability to hide alarms.
Hide Alarm Types Allow or Deny the ability to hide alarm types.
Clear Alarms Allow or Deny the ability to clear alarms.
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AZedit Features Window
Key Assignments Colors Allow or Deny the ability to change keypanel assignment colors for the color 
keypanel.

Function Type Colors Allow or Deny the ability to change the function type colors for the color 
keypanel.

Miscellaneous Keypanel Colors Allow or Deny the ability to change the miscellaneous keypanel colors for the 
color keypanel.

Change TM Communication 
Parameters

Allow or Deny the ability to change the TM communication parameters

Clear Ethernet Links Statistics Allow or Deny the ability to clear the Ethernet link status.
Reset Ethernet Links Allow or Deny the ability to reset the Ethernet links.
Edit the Port Allocation Table Allow or Deny the ability to edit the Port Allocation table.
Download License Files Allow or Deny the ability to download license files.

TABLE 4. AZedit Features

Feature Description
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Menu Features Window
Menu Features Window

Access Column
The Access column displays whether the menu item is allowed or denied to the user.

Feature Column
The Feature column displays the name of the menu item.

Allow Column Check Box
The Allow column is used to grant access to the menu item for modifications.

Deny Column Check Box
The Deny column is used to restrict access to the menu item for modifications.

FIGURE 56. Menu Features Window
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Menu Features Window
Inherited Column
The Inherited column displays the initial permission state of the resource, assignment or feature. In other words, if the user or 
class inherited permissions from another user, class or studio, those permissions are inherited, and displayed in this column.

The inherited state can be overridden by selecting Allow or Deny next to the resource, assignment, or feature.

TABLE 5. Menu Features List

Menu Feature Description
File Allow or Deny access to the File menu. 

NOTE: When File is restricted, every option in the File menu is restricted.
File/New Allow or Deny the ability to start a new file.
File/Open Allow or Deny the ability to open an AZedit setup file.
File/Merge Allow or Deny the ability to merge files.
File/Save Allow or Deny the ability to save files.
File/Save As Allow or Deny the ability to use save as to save files.
File/Partial Save Allow or Deny the ability to perform a partial save.
File/Print Allow or Deny the ability to print.
File/Print Preview Allow or Deny the ability to use print preview.
File/Print Setup Allow or Deny the ability to open the Print Setup window.
File/Exit Allow or Deny the ability to exit the application.
Online Allow or Deny access to Online with AZedit.

NOTE: When Online is restricted, every option in the Online menu is 
restricted.

Online/Connect Allow or Deny the ability to connect an AZedit session.
Online/Load File Allow or Deny the ability to load a file.
Online/Send File Allow or Deny the ability to send a file.
Online/Send Changes Allow or Deny the ability to send changes to the matrix.
Online/Abort Changes Allow or Deny the ability to abort changes.
Online/Server Mode Allow or Deny the ability to enter Server mode.
Authentication Allow or Deny access to the Authentication menu.

NOTE: When Authentication is restricted, every option in the 
Authentication menu is restricted.

Authentication/Change Intercom Allow or Deny the ability to change intercoms.
Authentication/Change User Allow or Deny the ability to change users.
Authentication/Change Password Allow or Deny the ability to change passwords.
Authentication/Show Connected 
Users

Allow or Deny the ability to show connected users.

Authentication/Configuration Allow or Deny the ability to configure authentication.
Authentication/Create Shortcut Allow or Deny the ability to create AZedit shortcuts.
Edit Allow or Deny access to the Edit menu.

NOTE: When Edit is restricted, every option in the Edit menu is 
restricted.
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Menu Features Window
Edit/Undo Allow or Deny the ability to undo modifications.
Edit/Redo Allow or Deny the ability to redo modifications.
Edit/Cancel Changes Allow or Deny the ability to cancel changes.
Edit/Cut Allow or Deny the ability to cut data from windows.
Edit/Copy Allow or Deny the ability to copy information from windows.
Edit/Paste Allow or Deny the ability to paste information into windows. 
Edit/Paste Special Allow or Deny the ability to perform a paste special.
Edit/Search For Key Assignments Allow or Deny the ability to search for a key assignment.
View Allow or Deny access to the View menu.

NOTE: When View is restricted, every option in the View menu is 
restricted.

View/Standard Toolbar Allow or Deny the ability to view the standard toolbar.
View/Standard Toolbar2 Allow or Deny the ability to view the standard toolbar2.
View/Navigation Toolbar Allow or Deny the ability to view the navigation toolbar.
View/Navigation Toolbar2 Allow or Deny the ability to view the navigation toolbar2.
View/Customize Toolbars Allow or Deny the ability to customize any toolbars in AZedit.
View/Status Bar Allow or Deny the ability to view the status bar.
View/Key Assignment Grid Allow or Deny the ability to use the key assignment grid.
View/Font Size Allow or Deny the ability to use the Font Size menu.

NOTE: When Fonts is restricted, every option in the Fonts menu is 
restricted.

View/Font Size/Extra Large Allow or Deny the ability to change the font size to Extra Large.
View/Font Size/Large Allow or Deny the ability to change the font size to Large.
View/Font Size/Medium Allow or Deny the ability to change the font size to Medium.
View/Font Size/Small Allow or Deny the ability to change the font size to Small.
View/Refresh Allow or Deny the ability to refresh the window.
View/Go Back Allow or Deny the ability to Go Back.
View/Go Forward Allow or Deny the ability to Go Forward.
System Allow or Deny access to the System menu or any of the windows associated 

with the system menu.

NOTE: When System is restricted, every option in the System menu is 
restricted.

System/Keypanel Assignment Allow or Deny access to the Keypanel Assignments window.
System/LCP102 Assignment Allow or Deny access to the LCP102 Assignment window.
System/PAP32 Assignment Allow or Deny access to the PAP32 Assignment window.
System/ARP32 Assignment Allow or Deny access to the ARP32 Assignment window.
System/Party Line Allow or Deny access to the Party Line Assignment window.
System/IFB Allow or Deny access to the IFB window.
System/IFB Priority Allow or Deny access to the Ifb Priority window.

TABLE 5. Menu Features List

Menu Feature Description
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System/PGM Listen Source Allow or Deny access to the PGM Listen Source window.
System/IFB Listen Destination Allow or Deny access to the IFB Listen Destination window.
System/IFB Special List Allow or Deny access to the IFB Special List window.
System/GPI Output Allow or Deny access to the GPI Output window.
System/GPIO16 Allow or Deny access to the GPIO16 window.
System/ISO Allow or Deny access to the ISO window.
System/GPI Input Allow or Deny access to the GPI Input window.
System/UPL Statements Allow or Deny access to the UPL Statements window.
System/UPL Resources Allow or Deny access to the UPL Resources window.
System/Assignment Group Allow or Deny access to the Assignment Groups window.
System/Auto Dial Allow or Deny access to the Auto Dial window.
System/Dim Table Allow or Deny access to the Dim Table window.
System/Crosspoint Allow or Deny access to the Crosspoint Status window.
System/Vox Allow or Deny access to the Vox window.
System/Gains Allow or Deny access to Gains flyout menu.

NOTE: When Gains is restricted, every option under Gains is restricted.
System/Gains/Crosspoint Gains Allow or Deny access to the Crosspoint Gains window.
System/Gains/Party Line Gains Allow or Deny access to the Party Line Gains window.
System/Gains/Input Output Gains Allow or Deny access to the Input Output Gains window.
System/Miscellaneous Allow or Deny access to the Miscellaneous flyout menu.

NOTE: When Miscellaneous is restricted, every option under 
Miscellaneous is restricted.

System/Miscellaneous/Keypanel 
Colors

Allow or Deny access to the Keypanel Colors window.

System/Miscellaneous/Keypanel 
Screen Saver

Allow or Deny access to the Keypanel Menu Screen Saver window.

System/Miscellaneous/Keypanel 
Menu Password

Allow or Deny access to the Keypanel Menu Password window.

System/Miscellaneous/RVON 
Configuration

Allow or Deny access to the RVON Configuration window.

System/Miscellaneous/MADI 
Configuration

Allow or Deny access to the MADI Configuration window.

System/Miscellaneous/Cronus 
Password

Allow or Deny access to the Cronus Password window.

Alphas Allow or Deny access to the Alphas menu.

NOTE: When the Alphas menu is restricted, every option in the menu is 
restricted.

Alphas/Port Allow or Deny access to the Port Alphas window.
Alphas/Party Line Allow or Deny access to the Party Line Alphas window.
Alphas/IFB Allow or Deny access to the IFB Alphas window.

TABLE 5. Menu Features List

Menu Feature Description
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Alphas/IFB Special List Allow or Deny access to the IFB Special List Alphas window.
Alphas/Special List Allow or Deny access to the Special List Alphas window.
Alphas/GPI Output Allow or Deny access to the GPI Output Alphas window.
Alphas/ISO Allow or Deny access to the ISO Alphas window.
Alphas/UPL Resource Allow or Deny access to the UPL Resource Alphas window.
Alphas/Assignment Group Allow or Deny access to the Assignment Group Alphas window.
Alphas/Auto Dials Allow or Deny access to the Auto Dials Alphas window.
Alphas/Special Functions
Alphas/GPI Input Allow or Deny access to the GPI Input Descriptions window.
Alphas/Dim Table Allow or Deny access to the Dim Table Descriptions window.
Alphas/IO Card Allow or Deny access to the IO Card Descriptions window.
Alphas/PAP and LCP102 Allow or Deny access to the PAP and LCP102 Descriptions window.
Alphas/Check for Duplicate Alphas Allow or Deny the ability to perform a check for duplicate alphas.
Alphas/Advanced Copy Utility Allow or Deny the ability to use the advanced copy utility.
Alphas/Refresh Alphas Allow or Deny the ability to perform a refresh alphas.
Status Allow or Deny access to the Status menu.

NOTE: When Status is restricted, every option in the Status menu is 
restricted.

Status/Port Allow or Deny access to the Port Status window.
Status/Master Controller Allow or Deny access to the Master Controller Status window.
Status/Standby Controller Allow or Deny access to the Standby Controller Status window.
Status/Crosspoint Controller Allow or Deny access to the Crosspoint Controller Status window. (Cronus 

feature only).
Status/DBX Links (TBX) Allow or Deny access to the DBX Links Status window.
Status/IO Cards Allow or Deny access to the IO Cards Status window.
Status/MADI Cards Allow or Deny access to the MADI Card Status window.
Status/PAP and LCP102 Allow or Deny access to the PAP and LCP102 Status window.
Status/UIO256 Allow or Deny access to the UIO256 Status window.
Status/Ethernet Links Allow or Deny access to the Ethernet Links menu.

NOTE: When Ethernet Links is restricted, every option in the Ethernet 
Links menu is restricted.

Status/Ethernet Links/FrametoFrame 
Links

Allow or Deny access to the Frame-To-Frame Links Status window.

Status/Ethernet Links/Trunk Master 
Links

Allow or Deny access to the Trunk Master Links Status window.

Status/Software Versions Allow or Deny access to the Software Version menu.

NOTE: When Software Versions is restricted, every option in the 
Software Versions menu is restricted.

Status/Software Versions/Master 
Controller

Allow or Deny access to the Master Controller Version Information window.

TABLE 5. Menu Features List
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Status/Software Versions/IO Cards Allow or Deny access to the IO Cards Version Information window.
Status/Software Versions/Keypanels Allow or Deny access to the Keypanel Version Information window.
Status/Software Versions/GPIO16 Allow or Deny access to the GPIO16 Version Information window.
Status/Trunk Master Allow or Deny access to the Trunk Master Status window.
Status/Trunk Ports Allow or Deny access to the Trunk Ports Status window.
Status/Remote Intercoms Allow or Deny access to the Remote Intercoms Status window.
Status/RVON Connections Allow or Deny access to the RVON Connections Status window.
Status/Alarms Allow or Deny access to the Alarms window.
Options Allow or Deny access to the Options menu.

NOTE: When Options is restricted, every option in the Options menu is 
restricted.

Options/Preferences Allow or Deny access to the Preferences window.
Options/Communications Allow or Deny access to the Communications window.
Options/Connect To Frame Allow or Deny access to the Connect To Frame menu.

NOTE: When connect to frame is restricted, every option in the connect to 
frame menu is restricted.

Options/Connect To Frame/Frame 1 Allow or Deny access to the Frame 1 Menu option is restricted.
Options/Connect To Frame/Frame 2 Allow or Deny access to the Frame 2 Menu option is restricted.
Options/Connect To Frame/Frame 3 Allow or Deny access to the Frame 3 Menu option is restricted.
Options/Connect To Frame/Frame 4 Allow or Deny access to the Frame 4 Menu option is restricted.
Options/Connect To Frame/Frame 5 Allow or Deny access to the Frame 5 Menu option is restricted.
Options/Connect To Frame/Frame 6 Allow or Deny access to the Frame 6 Menu option is restricted.
Options/Connect To Frame/Frame 7 Allow or Deny access to the Frame 7 Menu option is restricted.
Options/Connect To Frame/Frame 8 Allow or Deny access to the Frame 8 Menu option is restricted.
Options/Connect To Frame/Frame 
Auto Connect

Allow or Deny access to the Frame Auto Connect menu option is restricted.

Options/TM Communications Allow or Deny access to the TM Communications window.
Options/Intercom Configuration Allow or Deny access to the Intercom Configuration window.
Options/Frame Mapping Table Allow or Deny access to the Frame Mapping Table.
Options/Port Allocation Table Allow or Deny access to the Port Allocation Table.
Options/Reset Capabilities Allow or Deny access to the Reset Capabilities Menu option.
Options/Ethernet Setup Allow or Deny access to the Ethernet Setup window.
Options/SNMP Configuration Allow or Deny access to the SNMP Configuration window.
Options/GPIO Configuration Allow or Deny access to the GPIO Configuration window.
Options/Download License Allow or Deny access to the Download License window.
Options/Upload Debug Information Allow or Deny the ability to Upload Debug Information.
Logging Allow or Deny access to the Logging menu.

NOTE: When Logging is restricted, every option in the Logging menu is 
restricted.
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Logging/Disable Logging Allow or Deny the ability to disable logging.
Logging/Log to File Allow or Deny the ability to configure log to file.
Logging/Log to Serial Port Allow or Deny the ability to configure log to serial port.
Logging/Configure Logging Allow or Deny access to the configure logging window.
Logging/Log View Allow or Deny access to the Log View window.
Help Allow or Deny access to the Help menu.

NOTE: When Help is restricted, every option in the Help menu is 
restricted.

Help/Help Topics Allow or Deny access to Help topics.
Help/Using Help Allow or Deny access to using help.
Help/Release Notes Allow or Deny access to the release notes.
Help/Error Information Allow or Deny access to the Error Information window.
Help/About AZedit Allow or Deny access to the about AZedit window.
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CHAPTER 5

AZedit and Restrictions Editor
Introduction
Using AZedit and Restrictions Editor in conjunction gives you a powerful and secure application to run and manage your 
intercom system. This allows you the ability to limit what features or permissions your users have and do not have access to.

Initial Setup
When initially configuring Restrictions Editor for use with AZedit, do the following:

Step 1 Initial Log in to Restrictions Editor, see “Starting Restrictions Editor for the First Time” on page 8.
Step 2 Create Studios in Restrictions Editor, see “Create a New Studio” on page 68.
Step 3 Create Classes in Restrictions Editor, see “Create a New Class” on page 68.
Step 4 Create Users in Restrictions Editor, see “Add a New User” on page 62.
Step 5 Configure Restrictions Editor in AZedit.

Configure Restrictions Editor in AZedit
ResEdit stores the restrictions in C:\Telex\ResEdit\RES. Verify AZedit is pointed at this directory using Options | Preferences 
| Authentication. 

There are two (2) configuration fields in AZedit: 

• Restrictions Files, pointed to C:\Telex\ResEdit\RES 
• Restriction Cache Files, pointed to C:\Telex\AZedit\RES

The reason for the two (2) directories is the first may be a network drive. When AZedit starts up, it looks at the first directory 
for the restriction file and if it finds it, it copies it to its local Cache directory. That way if the network is unavailable, AZedit 
can always fall back to the locally cached copy.

NOTE: These two (2) directory settings are configured per user per intercom in AZedit. When you change a user or 
intercom, you must make sure these settings are correct for the current user/intercom.
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Configure Restrictions Editor in AZedit
To configure Restrictions Editor in AZedit, do the following:

1. From the AZedit menu bar, select Options|Preferences|Authentication.
The Preferences Window appears.

2. In the Restrictions File (.RES) field, enter the file path where the restriction file currently resides. (e.g., 
C:\Telex\ResEdit\RES).

3. In the Restrictions Cache File (.RES) field, enter the file path where the local copy of the restriction file will reside 
(e.g., C:\Telex\AZedit\RES).

4. Click Apply.
5. Click OK.
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CHAPTER 6

Operation
How to Hide and Display the Context Navigation Tree
To hide the context navigation tree, do the following:

 > From an expanded Context Navigation Tree, select the collapse icon.
The tree and its branches collapse to close.

To display the context navigation tree, do the following:

 > From a collapsed Context Navigation Tree, select the expand icon.
The tree and its branches collapse to close.
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Add a New User
Add a New User

IMPORTANT: Integrating Restrictions Editor to an existing AZedit program that currently has established users in the 
system (via Authentication), to avoid confusion, be sure the user name record in both applications 
match exactly to avoid duplicate records. User names are case sensitive. AZedit accesses the list of 
users for an intercom from the registry. However, when AZedit detects a restriction file, it reads the 
restrictions file user name table first.

To add a new user, do the following:

1. In the Context Navigation Tree, click Users.
The User:Configuration window appears in the Data View.

2. Click Add.
The Add New User window appears.

3. In the Create New User group box, select where the permissions are pulled from.
4. In the Enter the new User name field, enter the name of the user.
5. Click OK.

The new user profile is created with the specified restrictions.
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Delete a Studio, Class, or User
Delete a Studio, Class, or User

To delete a studio, class or user, do the following:

1. From the Studio column, select the Studio you want to delete.
OR
From the Class column, select the Class you want to delete.
OR
From the User column, select the User you want to delete.

2. Click Delete.
A confirmation window appears.

3. Click Yes.
The Studio, Class, or User is deleted from the restriction file.

Rename a Studio, Class, or User

To rename a studio, class or user, do the following:

1. From the Studio column, select the Studio you want to rename.
OR
From the Class column, select the Class you want to rename.
OR
From the User column, select the User you want to rename.

2. Click Rename.
The Rename window appears.

3. In the Enter new name field, enter the new name (up to 24 characters).
4. Click OK.

Show/Hide the Status Bar
To show/hide the status bar, do the following:

 > From the View menu, select Status Bar.
If a check mark appears next to Status bar, the status bar appears. If there is no check mark next to Status Bar, the 
status bar.
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Change the Intercom Connection
Change the Intercom Connection
To change the intercom connection, do the following:

1. From the File menu, select Change Intercom.
The Select Intercom window appears.

2. From the Intercom column, select the intercom system you want to connect to.
3. Click OK.

NOTE: To make an intercom system the default connection, click Default. A check mark appears next to the 
intercom system name.
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Set Save Preferences for Restriction Files
Set Save Preferences for Restriction Files
By default, the paths for the following fields are:

To set save preferences for restriction files, do the following:

1. From the options menu, select Preferences.
The Preferences window appears.

2. Select the Single click radio button to configure single clicks to make restriction setting modifications.
OR
Select the Double click radio button to configure double clicks to make restriction setting modifications.

3. Select the 4 Characters radio button to allow 4-character alphas to display.
OR
Select the 6 Characters radio button to allow 6-character alphas to display.
OR
Select the 8 Characters radio button to allow 8-character alphas to display.

4. In the Menu Restrictions (AZedit.EXE) field, enter the folder path where you want menu restrictions saved.
5. In the AZedit Restriction Files (.RES) field, enter the folder path where you want AZedit restrictions saved.
6. In the Intercom Configuration Files (.CFG) field, enter the folder path where you want intercom configuration files 

saved.
7. Click OK.

Menu Restrictions (AZedit .EXE) C:\Telex\AZedit\V3XX\AZedit.exe
AZedit Restriction Files (.RES) C:\Telex\ResEdit\RES
Intercom Configuration Files (.CFG) C:\Telex\ResEdit\CFG
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Save Restriction Files
Save Restriction Files
When you save restriction files, the application saves the current restriction settings to the appropriate .RES field (named for 
the intercom). If you attempt to exit the application while there are unsaved changes the application prompts you to save 
before exiting.

To save a restriction file, do the following:

 > From the File menu, select Save Restrictions.
The Restrictions are saved to a predetermined folder on your network.

Export Restriction Files
Export Restrictions is similar to Save As. If you have a restrictions file for Intercom A, but you want to create a restrictions 
file for Intercom B that starts from the Intercom A settings, you can open the file for Intercom A and Export Restrictions to 
create a file for Intercom B.

To export restriction files, do the following:

1. From the File menu, select Export Restrictions.
The Export to Intercom window appears.

2. In the Name field, enter the name of the intercom system (up to 24 characters).
OR
Use the browse button to select an intercom system.
The IP Address of the selected intercom system appears in the Main field.
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Create a Shortcut to Restrictions Editor
Create a Shortcut to Restrictions Editor
To create a shortcut to Restrictions Editor on your desktop, do the following:

1. From the Options menu, select Create Shortcut.
The Create a Desktop Shortcut window appears.

2. Select the Intercom check box if you want the name of the intercom to display in the Shortcut name.

NOTE: The current intercom name is shown in the text field next to the Intercom check box. You can modify this 
name, if desired.

3. In the Shortcut Name field, enter a unique name for the shortcut, if desired (up to 24 characters).
4. In the Description field, enter a short description of the application shortcut.
5. Click OK.

The shortcut appears on your PC desktop.
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Create a New Studio
Create a New Studio
To create a new studio, do the following:

1. In the Context Navigation Tree, click Studios.
The Studio:Configuration window appears in the Data View.

2. Click Add.
The Add New Studio window appears

3. In the Enter the new studio name field, enter the studio name (up to 24 characters).
4. Click OK.

The Studio is created and appears in the Context Navigation Tree.

Create a New Class
To create a new class, do the following:

1. In the Context Navigation Tree, click Class.
The Class:Configuration window appears in the Data View.

2. Click Add.
The Add New Class window appears

3. In the Create New Class group box, select where the permissions are pulled from.
4. In the Enter the new Class name field, enter the name of the class (up to 24 characters).
5. Click OK.

The new user profile is created with the specified restrictions.
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Select Button Sizes
Select Button Sizes
To select button sizes, do the following:

1. Left-click anywhere in the Resource Navigation Bar pane.
A popup menu appears.

2. From the popup menu, either select Small buttons or Large buttons.

Set Single or Double-Clicks to Modify Restrictions
To set single or double-clicks to modify restrictions, do the following:

1. From the Options menu, select Preferences.
The Preferences window appears.

2. From the Change restrictions settings with... group box, select either the Single click or Double click radio button.
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Modify Restrictions
Modify Restrictions
To modify restrictions in Restrictions Editor, do the following:

1. From the Context Navigation tree, select a specific class or user.
All the applicable Resource Navigation Bar buttons become active.

2. Select a Resource Navigation Bar button (for example, Keypanels).
The resources for keypanels appears in the Data View pane.

3. Select Allow to allow users access to modify this resource.
OR
Select Deny to deny users access to modify this resource.
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Notes
Notes
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